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June 2020 Photoshop, Lightroom, Bridge Updates 

In this lesson, we’re going to look at the updates 
made to Photoshop, Lightroom and Bridge in 
June of 2020. Note that there is a separate les-
son video (and handbook) on the updates that 
were made to Adobe Camera Raw. 

The first thing you might notice is that the Ado-
be logo has been updated. You’ll still see the 
old one in some locations (for the time being) 
as they gradually update the entire product line. 

Bridge Updates (Timestamp 1:26) 

Many of the updates to Bridge can be found 
in the Custom Export dialog, which can be ac-
cessed by clicking on the File menu and choos-
ing Export To > Custom Export. This is where 
you can specify settings for saving an image 
out as a certain file format. The following are 
some of the updates here:

• Added DNG, TIFF & PNG format support (it formerly only offered JPEG)

The Adobe logo was updated along 
with this new set of software updates.

In the Export 
dialog, you 
now have the 
options of 
exporting in 
the PNG, DNG 
and TIFF file 
formats.

Here, you can see the old (left) and 
new icons for Adobe Bridge.
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• PNG & TIFF now offer transparency support.

• You can now resize based on the short or long edge. 

• Toggle transparency options: There are now options for how Bridge displays 
transparency and they can be accessed by clicking the transparency options 
icon in the top right corner of the image window. 

The old Export dialog is shown directly above the new one. In the new dialog, you can see 
that you can use the highlighted menu to resize the image to the long or short edge. 

You can access the transparency  
options by clicking on the icon at 
the top of the interface.
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Lightroom Updates for the Cloud-based Version (9:50)

BASIC CHANGES

• There are new choices for raw defaults 
in the Import Dialog (Default, Camera 
or Preset).

• There are new Adobe default settings 
to choose from (Profile + Lens Correc-
tion + NR).

• There is a new feature known as Ver-
sions (similar to snapshots in ACR/LR). 

• Local Hue adjustments: You can now 
control the hue of an area targeted with 
the Adjustment Brush, Radial Filter and 
Graduated Filter. 

• You can now apply watermarks on ex-
port.

• There is a new section that contains 
notifications for likes or comments on 
shared albums. 

Here, you can see the old (left) and new 
icons for the Cloud-based version of  
Lightroom.

A new Hue slider has been added within 
the adjustments for the Adjustment Brush, 
the Graduated Filter and the Radial Filter.
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Lightroom Classic Updates for Desktop Version 9.3 (13:10)

Bug Fixes:

Here, you can see the old (left) and new 
icons for Lightroom Classic (the desktop 
version of Lightroom).
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New Camera & Lens Support 
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Basic Changes

• Video Playback (not supported on Windows 7)

• HEVC Video support on Windows 10

• AVI Support on Mac OS

• Preferences > External Editing: Tiff compression setting is now respected (In the 
past, there was a Tiff compression option but it never actually went into effect.)

• Cloud sync status icons In the past, the cloud syncing status would appear 
within the Identity plate, in the upper left corner of the screen. Now, this cloud 
icon has a more prominent location, to the right of the module names at the top 
of the interface. This cloud icon will change based on the status of any images 
that are synced to Lightroom in the cloud.  

Cloud sync icons, from left to right:

1. All images have successfully been synced.

2. Actively syncing

3. You or some other process paused the syncing. Click the icon to tell it to start 
syncing again,

4. Nothing is syncing.

5. Lightroom cannot currently access the cloud server, which usually means that 
you’re not online. 

6. Orange warning: You’re running out of space on Adobe’s servers.

7. Red warning: You have run out of space on Adobe’s servers.

8. Gray warning: There is some type of error, creating problems syncing images to 
the cloud.
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ACR 12.3 is  Needed

• Any time you update Lightroom, you need to also update Adobe Camera Raw 
to the matching version (ACR 12.3 in this case). 

Basic Changes to the Library Module

• Faster grid scrolling

• Faster collection filtering

• Expanded batch export settings

• Facebook published images moved to new collection

Basic Changes to the Develop Module

• Adjustment sliders are more fluid

• Crop Tool: New center overlay

• Local Hue Adjustment

• Updated Curves interface

• Updated HSL/Color interface

• ISO Adaptive Presets

• New Adobe default settings (Profile + Lens + NR)
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Lightroom Classic Updates In-Depth (23:52)

Cloud Syncing The cloud syncing status now appears in the top right corner of the 
interface and is in the form of a cloud icon. Click this icon and a small dialog will 
appear, presenting you with the syncing options. Here, you can pause and continue 
the syncing. To sync a collection to the Cloud, click on the square to the left of the 
Collection’s name in the Collections Panel. The icon will change and that Collection 
will start to sync with the Cloud.

Expanded Batch Export Settings (25:23)

To batch export a series of images, you can click on the File menu, choose Export 
with Preset and then select a single preset with which to export all selected imag-
es. You can also export the selected images with multiple presets by clicking on 
the File menu and choosing Export. The Export dialog will appear and all of your 
export presets will appear on the left. Turn on the check boxes for all presets you 
would like to use. This functionality is not new. 

LEFT: Click the cloud icon (circled) to  
access the Cloud-syncing settings.

ABOVE: Click the square to the left of a 
Collection name to sync that Collection 
with the Cloud. When synced, the circled 
icon will appear. 
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What IS new is the Batch Export button in the bottom right corner of the Export 
dialog. When you click on this, the Batch Export dialog appears and here you will 
find some settings associated with each preset you had selected. This allows you 
to bypass the settings that are found in those selected presets. If you turn on the 
“Choose Parent Folder” check box at the top of the dialog, you can choose a dif-
ferent folder in which to place the images. Each of the listed presets will also allow 
you to create a subfolder in which to place the images exported with that particu-
lar preset. 

If the selected presets require you to type in custom text for the file names, these 
text fields will be available in this dialog as well. Click the Export button to export 
the selected images with the chosen presets. 

LEFT: In the Export dialog, you can turn on the check boxes for all presets that you would 
like to use upon export. Then click the Batch Export button in the bottom right corner.  
RIGHT: The Batch Export dialog allows you to bypass some of the settings for the individual 
export presets you have selected.



June 2020 Photoshop, Lightroom, Bridge Updates © Ben Willmore, All rights reserved 11

Hue Setting for Localized Adjustments (29:03)

In Lightroom’s Develop Module, a new slid-
er has been added within the settings for 
the local adjustment tools (the Adjustment 
Brush, Graduated Filter & Radial Filter) It 
is called the Hue slider and it is displayed 
as a gradient of all the hues that could be 
present in an image. Once you’ve used the 
Adjustment Brush (or other local adjust-
ment) to isolate an area in the picture, a lit-
tle circle will appear on top of the color that you’ve isolated in the Hue slider. If you 
click that circle and drag left or right, it will replace that color with whatever color 
can be found in the top bar of the gradient. Once you are close to the color that 
you want, you can turn on the “Use Fine Adjustment” check box and further refine 
the hue. With this setting turned on, you can click and drag but it will only move the 
circle in very small increments, allowing for much more precision. Instead of turning 
on the check box, you can alternatively hold down the Option key (Alt on Win) in 
order to get this fine adjustment behavior. After you’ve adjusted the Hue slider, a 
Saturation slider will appear below it so you can fine tune how colorful the hue is. 

Redesigned Curves Panel (32:30)

The Tone Curve Panel has had some significant changes in 
this new version of Lightroom. In the old version, there were 
two types of curves that could be used and you could switch 
between the two by clicking on the little icon in the bottom 
right corner of the panel. One type of curve was the Paramet-
ric Curve, which is the type that you adjust by moving slid-
ers around. (Highlights, Lights, Darks, etc.) The second type of 
curve is the Point Curve, and this is where you can click to man-
ually add points on the curve and move them around to change 

A new Hue slider has been added within 
the adjustments for the Adjustment Brush, 
the Graduated Filter and the Radial Filter.

The OLD Tone Curve 
panel.
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the tones in your image. Below the point curve was the channel menu, which was 
set to RGB by default. With the RGB curve, you could only affect the brightness. 
The individual color curves could be used to work on each color individually. 

The new Curve panel takes up a lot less space and 
there are icons along the top that allow you to 
choose which type of curve you’re going to work 
on. The icon on the far left is the Parametric Curve. 
When this icon is active, the sliders will appear 
beneath the curve chart. The second icon, which 
looks like a gray circle, is the equivalent to the RGB 
point curve, which will only affect the brightness. 
The next three icons are the color curves. When 
a color curve is active, there is now a color gradi-
ent within the chart that shows what colors you’re 
working with. For example, the red curve can be 
used to affect the reds and the cyans, which is 
red’s opposite. When you move the curve away from red, you’re adding cyan, and 
vise versa. This red-to-cyan gradient now appears on the chart. The same goes for 
the other two color curves. The green curve will be green and magenta (green’s 
opposite) and the blue curve will be blue and yellow (blue’s opposite). 

Some new curve settings can be found by 
right-clicking on the curve to access a pop-up 
menu. These include the ability to delete the ac-
tive control point, reset the active curve, copy the 
curve settings, etc. At the bottom of this menu is 
the option to Show All Curves. This is turned off 
by default but I like to keep it turned on. When 
this setting is turned on, all of the curves will be 
overlaid on the curve chart. This allows you to see 
the RGB curve, the red curve, blue curve, etc. all 
at once. This can be nice because it allows you to 
see which curves have been used and how they’re 
affecting the image. 

The new Tone Curve panel now 
shows a color gradient when one 
of the color curves is active.

Right-click on the curve in order 
to access a setting that allows 
you to view all the curves at once.
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The HSL/Color Panel (36:06)

The HSL/Color Panel gives you the choice between working with HSL or Color. You 
can click between the two names at the top of the panel.  If you choose HSL, it will 
allow you to work on the Hue, the Saturation or the Lightness and there will be a 
slider for every color in each of these categories. If you set the menu to Color, you 
can choose one color and then you’ll get three sliders for that color: one for Hue, 
one for Saturation and one for Lightness. These options have not changed since 
the previous version. They just changed the look a bit. When working in the Color 
setting, all of the color options now appear across the top of the panel as circles 
and it’s easier to see what colors they are. The circle on the far right looks like a 
rainbow. Clicking this option will present you with the sliders for all the colors at 
once. 

ISO Adaptive Presets (37:10)

There are now presets that will look at the ISO that each image was captured at 
and it will adapt to apply different settings based on how high the ISO was. 

To create one of these presets, select multiple images with different ISO settings. 
Adjust the images using the adjustment sliders and then individually apply the De-
tail settings (Noise Reduction) to each image. 

LEFT: The HSL/Color panel, when working 
with the HSL settings. RIGHT: The HSL/Color 
panel, when working with the Color settings.
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Select all of the images that will 
be used to create the ISO Adap-
tive Preset. Then, click on the 
little plus icon ( + ) at the top 
of the Presets Panel on the left 
side of the screen. A little pop-
up menu will appear. Choose 
“Create Preset” and the New De-
velop Preset dialog will appear. 

In this dialog, turn on the check boxes for all of the adjustments you’d like to be 
included in the preset AND be sure to turn on the Noise Reduction check box. 

Because multiple images are selected, the “Create ISO adaptive preset” will appear 
at the bottom of the dialog. This is the feature that is new to this version of Light-
room. Turn this check box on and then click the Create button to create the preset. 

To create a new Develop Preset, click on the little  
plus icon at the top of the Presets Panel and choose 
“Create Preset.”

The new “Create ISO adaptive preset” check box will appear at the bottom of the New Preset 
dialog when the Noise Reduction check box is turned on.
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Now, when you go to apply the preset, it 
will look at the ISO of the image and ap-
ply the noise reduction settings based 
on the settings used for the images used 
when creating the preset. For example, 
if you used a noise reduction setting of 
30 on an image with ISO 800, it will ap-
ply that same noise reduction setting on 
other images with ISO values of 800. If 
you apply the preset to an image with 
an ISO of 400, it will adapt that setting 
to reflect the lower ISO and therefore 
apply a lower noise reduction setting. 

To apply a preset to an image or imag-
es, select the image[s], expand the Pre-
set Panel on the left side of the Devel-
op Module and click on the preset you’d 
like to apply. If more than one image 
is selected, you will need to make sure 
the button in the bottom right corner of 
the screen is set to Auto Sync. This will 
cause Lightroom to apply settings to all 
selected images. 

In the video example, we created a pre-
set where the only setting applied was 
noise reduction. This preset is designed 
solely to set the images’ noise reduction 
settings based on the ISO that was used 
upon capture.  

To apply a preset to an image, or images,  
select the image[s], expand the Preset Panel 
in the Develop Module and click on the name 
of the preset you want to apply.
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Raw Defaults Presets (43:18)

If you expand the Presets Panel in the Devel-
op Module, you will now find a new category 
of presets, titled Defaults. These are presets 
created by Adobe. The preset called Adobe 
Default will use the default setting that has 
been used in Lightroom for a very long time. 
The Camera Settings preset will try to simu-
late the look that your camera was creating.

The Adobe Color presets are available here, 
but there are multiple versions of these, be-
cause Adobe has combined them with vari-
ous lens correction and noise reduction set-
tings. These noise reduction presets also use 
the ISO adaptive preset technology. 

Apply Presets on Import (44:45)

The Presets category of the Lightroom Preferences dialog now becomes more 
useful due to these new ISO Adaptive Presets. (You can access the Preferences 
dialog by clicking on the Lightroom menu and choosing Preferences. In Windows, 
the Preferences option can be found under the Edit menu.) 

Click on the Presets category at the top of the Preferences dialog and a Master 
menu will appear near the top. This Master menu can be used to specify what 
presets should be applied to your images automatically when imported into Light-
room. If you create ISO Adaptive Presets, then they can apply the appropriate 
noise reduction, varying the setting based on how high the ISO was. 

There is a new category called Defaults 
in the Develop Presets Panel.
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If you have multiple cameras, you can use the “Available Cameras” menu to set a 
different preset for each camera. Note that you will need to turn on the “Override 
master setting for specific cameras” check box in order to use a different preset for 
different cameras. 

In the Presets category of the Preferences dialog, you can use the Master menu to specify 
what preset should be applied to all images upon import. Turn on the “Override master  
setting for specific cameras” check box if you would like to apply different presets to the  
images based on what camera they were shot with.
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Updates to Photoshop with Version 21.2 (49:12)

BASIC UPDATES

• Auto-activate Adobe Fonts: If you open a 
document that has Adobe fonts not cur-
rently installed on your machine, it will au-
tomatically download and install the fonts. 
If you open a document that contains 
non-Adobe fonts that are not installed, a 
warning icon will appear in the Layers Pan-
el for the layer[s] containing the fonts. 

• The Type > Match Font feature has been improved.

• The Select Subject feature has been enhanced to work better with people and 
hair.

• Rotatable patterns: There is now an angle setting within the pattern layer style.

• The performance of the Object Selection Tool has been improved.

• Select & Mask: The Shift Edge and Smooth Performance sliders have been im-
proved.

The old (left) and new Photoshop icons.

The center  
image shows 
the results of 
the Select  
Subject  
command on 
the old version. 
The right image 
shows the result 
using the new 
version.
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• Photoshop Improvement Program: This is a setting within the Preferences di-
alog. If you turn the setting on, then it can look at your use of certain features 
and send information to Adobe so they can try to improve the software. It’s im-
portant to know that Adobe will also have access to the images you are working 
on, so it’s best to keep this setting turned off if you are working with sensitive 
images. Note that you will need to restart Photoshop in order for this setting to 
take effect. 

The setting to participate in the Product Improvement program can be found in the  
Preferences dialog.
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Photoshop Updates In-Depth (56:08)

Match Font This feature will at-
tempt to match your font to 
some text that is found within 
the image. To use this, create the 
type layer and make sure that it 
is active. Then, make a selection 
around the area in the picture 
that you want it to analyze. This 
will be the area containing the 
text with the font you like. Then, click on the Type menu at the top of the screen 
and choose “Match Font.” The Match Font dialog will appear and it will present you 
with a list of fonts that it thinks are similar to the text you have selected. 

There is a check box at the bottom of this dialog, called “Show fonts available to 
activate from Adobe Fonts.” If this check box is turned off, it will only list fonts that 
are currently installed on your computer. If you turn this check box on, then it will 
do a search of all Adobe fonts. To use one of these, click on the font to select it and 
then click on the little download icon to the left of the font’s name. This will down-
load the font and apply it to the active type layer. 

The type layer is active and a selection was made 
around the text that we want to match.

The Match 
Font command 
presents a list 
of fonts that 
most closely 
match the  
selected text.
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Rotate Pattern As we mentioned earlier, you now have the ability to rotate patterns 
in Photoshop. To apply a pattern, activate the layer you’d like to apply the pattern 
to, click on the FX icon at the bottom of the Layers Panel and choose Pattern Over-
lay from the pop-up menu. The Pattern Overlay settings will appear and you will 
see that there is now an Angle setting that can be used to rotate the chosen pat-
tern. This Angle setting is available in all areas of Photoshop where you can apply 
a pattern. 

When applying a pattern, there is now an Angle setting, which allows you to rotate the  
chosen pattern.


